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Tutorial: Get Running with
Amos Graphics

Purpose
Remember your first statistics class when you
sweated through memorizing formulas and
laboriously calculating answers with pencil and
paper? The professor had you do this so you would
understand some basic statistical concepts. Later

you discovered that a calculator or software program could do all these calculations
in a split second.

This tutorial is a little like that early statistics class. There are many short cuts to
drawing and labeling path diagrams in Amos Graphics that you will discover as
you work through the Examples in this User’s Guide, or as you review the Amos
4.0 Graphics Reference Guide. The intent of this tutorial is to simply get you
started using Amos Graphics in Microsoft Windows. It will cover some of the
basic functions and features of Amos and guide you through your first Amos
analysis. Once you have worked through this tutorial, you can learn more advanced
functions in the companion Amos 4.0 Graphics Reference Guide (either the PDF
document or Help file). Or you can continue to incrementally learn about Amos
and its statistical applications by working through the Examples in this User’s
Guide.

Please note that there are two versions of this tutorial. The exercise
Getstart.amw  uses data from a Microsoft Excel file, while Startsps.amw
points to input data in SPSS format. Both exercises are located in the Tutorial
subdirectory, underneath Amos 4 , typically in
C:\Program Files\Amos 4\Tutorial .
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Prerequisites
This tutorial assumes that Amos has been installed on your computer. If you have
not yet installed Amos, you might want to install it now, before continuing with
this tutorial. Also, this tutorial assumes that you already have some basic
experience using Windows programs. We assume you already know how to select
an item from a menu, how to move the mouse pointer, clicking and double-clicking
the mouse, and so on.

The data
Hamilton (1990) provided several measurements on each of 21 states. Three of the
measurements will be used for the present example: 1) average SAT score, 2) per
capita income expressed in $1,000 units, and 3) median education for residents 25
years of age or older. The data are provided in the Tutorial directory, inside
the Excel 8.0 workbook Hamilton.xls , in the single worksheet named
Hamilton . Here is a listing:
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The path diagram in Figure 1 shows a model for these data:

 

Education

Income

SAT Other
1

Figure 1

It is a simple regression model where one observed variable, SAT, is predicted as a
linear combination of the other two observed variables, Education and Income. As
with nearly all empirical data, the prediction will not be perfect. The latent variable
Other therefore serves to absorb random variation in the SAT scores and
systematic components for which no suitable predictors were provided.

Each single-headed arrow represents a regression weight. The number “1” in the
figure specifies that Other must have a weight of one in the prediction of SAT.
Some such constraint must be imposed in order to make the model identified, and it
is one of the features of the model that must be communicated to Amos. You need
to provide Amos with information about both the Hamilton data and the model in
Figure 1.   

Starting Amos Graphics
The are several ways to start up Amos Graphics:

1. You can double-click on the Amos Graphics icon on the Windows desktop.

2. From the Windows taskbar, you can launch Amos Graphics with the
command path

Start → Programs → Amos 4 → Amos Graphics

3. You can double-click on any path diagram (*.amw ) file created with Amos
Graphics.

4. You can double-click on a path diagram displayed by Amos’s View Path
Diagrams utility.

5. If you have the SPSS version of Amos, you can also start Amos Graphics
from SPSS by the Statistics → Amos command.
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After Amos Graphics has started up, click on File → New to start a new model.
You will see a window containing a large rectangle and several menu titles:

 

The large rectangle (in the center of the window) represents a sheet of paper. Its
shape depends on how your printer is set up. In this example, the printer is set up in
portrait mode, so the rectangle is taller than it is wide. If your printer is set for
landscape printing, the rectangle will be wider than it is tall.
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In addition to the Amos Graphics main window, Amos
displays a toolbar window with “button” or icon
commands that are shortcuts for drawing and modeling
operations (as shown on the left).

You have a choice of running Amos Graphics
commands either by clicking on their toolbar icons or by
selecting their corresponding menu commands.

Actually, Amos features even more icon shortcuts than
the ones shown here on the default toolbar. The Amos
4.0 Graphics Reference Guide (either the PDF document
or Help file) covers how to customize your toolbar so
you have immediate access to your most-used shortcuts.



18  •  Tutorial: Get Running with Amos Graphics                                 Amos 4.0 User’s Guide

Attaching the data
The next step is attaching the Hamilton data to the model. While inputting ASCII
(or text) based data input is possible, Amos Graphics supports input of several
common database formats, including SPSS *.sav  files. For the tutorial, we will
attach a Microsoft Excel 8.0 file of the Hamilton data. Do this by selecting:

File → Data Files... → File Name

We placed the data for this tutorial in the Tutorial  subdirectory. The directory
path is:

Program Files  → Amos 4  →Tutorial

In the Files of type listbox, select Excel 8.0 (*.xls)  as the desired file type
and double click on the Hamilton.xls  file:



 Amos 4.0 User’s Guide                                Tutorial: Get Running with Amos Graphics  •  19

This will bring you back to the Data Files dialog box. Click on OK :

 

Reading data from an SPSS system file
The SPSS version of Amos 4.0 reads the current SPSS working file when Amos is
started directly from the SPSS Statistics menu. Even when run in standalone mode,
all versions of Amos 4.0 can read SPSS (*.sav ) files saved to disk. To read an
SPSS file, such as the file Hamilton.sav  in the Tutorial  subdirectory,
simply follow the same steps outlined in the previous section. However, when you
get to Files of type, click on SPSS (*.sav)  as the desired file type and double
click on the Hamilton.sav file.

There is one difference to naming variables when working with SPSS data files.
SPSS system files support variable names of up to eight characters. Thus, if the
Hamilton data file was in the SPSS format, the variable name Education would
have to be shortened to Educatn.
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Specifying the model and drawing variables
First, draw three rectangles to represent the three observed variables in the model.
Begin by clicking on the Draw observed variables icon on the toolbar, or by
clicking on the Diagram menu and selecting Draw Observed:

 

When you click on an icon, you will know it is activated because its appearance
will change. The color surrounding the icon image will be brighter, as if
illuminated. Move the mouse pointer to the place where you want the Education
rectangle to appear in the drawing area. Do not worry too much about the exact
size or placement of the rectangle — you can change it later on. Once you have
picked a spot for the Education rectangle, press the left mouse button and hold it
down while making some trial movements of the mouse. Movements of the mouse
will affect the size and shape of the rectangle. When you are reasonably satisfied
with its appearance, release the mouse button. Now, use the same method to draw
two more rectangles for Income and SAT. As long as the Draw observed
variables icon is illuminated, a new rectangle will appear every time you press the
left mouse button and move the mouse.
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Next, draw an ellipse to represent Other. Ellipses are drawn the same way as
rectangles, except that you begin by clicking on the Draw unobserved variables
icon, or selecting Draw Unobserved from the Diagram menu. After drawing the
ellipse, your screen should look more or less like Figure 2 (except on a gray
background).

 
Figure 2
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Naming the variables
To assign names to the four variables, double click on one the objects in the path
diagram. It does not matter which one you start with. For this example, we will
start by double clicking on the rectangle that is supposed to represent Education.
The Object Properties dialog box appears. Click on the Text tab and enter the
word Education in the Variable name field:

 

Notice that while you are typing in the field, the word Education is appearing in
your first rectangle. Click once on the next rectangle and enter Income in the
Variable name field.

Remember that SPSS files cannot be longer than eight characters.
To compensate, you would need to enter Educatn in the Variable
name field and the proper Education in the Variable label field.
This modification is not needed for this tutorial because we are
using an Excel file.
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Follow this procedure until you have labeled all four objects. To close the Object
Properties box, click on the x in the upper right hand corner of the dialog box.
Your path diagram should look like Figure 3:
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Figure 3

Drawing arrows
To draw a single-headed arrow, click on the Draw paths icon from the toolbar.
When you move your mouse into the drawing arrow, you will notice that mouse
pointer has the word PATH underneath it to remind you that you are drawing a
path. You will also notice that when your pointer touches an object, the object
changes color. Click and hold down your left mouse button from the right edge of
the Education rectangle to the left edge of the SAT rectangle. Release the mouse
button and the arrow will be fixed into place. Repeat this procedure for each of the
remaining single-headed arrows. Use Figure 1 on page  as your model.

Drawing double-headed arrows is similar to drawing single-headed arrows. Simply
click on the Draw covariances icon on the toolbar. Then, click and hold down
your left mouse button from the left edge of the Income rectangle to the left edge
of the Education rectangle. The reason why we suggested starting at the bottom
variable is because the initial curvature of the two-headed arrow follows an arc in a
clockwise direction. That means going from bottom to top will curve the arrow to
the left. If you accidentally arc your arrow in the wrong direction, you can always
change it. We will discuss how to make changes to your path diagram a little later.
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Your path diagram should now look like Figure 4:
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Figure 4

Constraining a parameter
To identify the regression model, you must define the scale of the latent variable
Other. You can do this by fixing either the variance of Other or the path
coefficient from Other to SAT at some positive value. Suppose you want to fix the
path coefficient at unity. Double click on the arrow between Other and SAT. Once
again the Object Properties dialog appears. Click on the Parameters tab and
enter the value “1” in the Regression weight field:
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This adds a “1” above the arrow between Other and SAT. To close the Object
Properties box, once again click on the x in the upper right hand corner of the
dialog box. This completes the path diagram except for any changes you might
want to make to improve its appearance. It should look something like Figure 5:
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Figure 5

1

Improving the appearance of the path diagram
You can change the appearance of your path diagram by moving objects around,
and by changing their sizes and shapes. These changes do not affect the meaning of
a path diagram. That is, they do not change the model’s specification. To move an
object, click on the Move icon on the toolbar. You will notice that the picture of a
little moving truck appears below your mouse pointer when you move into the
drawing area. This lets you know the Move function is active. Then click and hold
down your left mouse button on the object you wish to move. With the mouse
button still depressed, move the object to where you want it, and let go of your
mouse button. Amos Graphics will automatically redraw all connecting arrows.

To change the size and shape of an object, first press the Change the shape of
objects icon on the toolbar. You will notice that the word shape appears under the
mouse pointer to let you know the Shape function is active. Click and hold down
your left mouse button on the object you wish to re-shape. Change the shape of the
object to your liking and release the mouse button.

Change the shape of objects also works on two-headed arrows. Follow the same
procedure to change the direction or arc of any double-headed arrow.

Of course, if you make a mistake, there are always three icons on the toolbar to
quickly bail you out: the Erase and Undo functions. To erase an object, simple
click on the Erase icon and then click on the object you wish to erase.
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To undo your last drawing activity, click on the Undo icon and your last activity
disappears. Each time you click Undo, your previous activity will be removed.

If you change your mind, click on Redo to restore a change.

No matter how carefully you try to adjust the size, shape and location of individual
objects in your path diagram, the path diagram as a whole will probably end up
looking slightly out of kilter. You might, for example, want the Education and
Income rectangles to look exactly alike, but it is very hard to do this simply by
eyeballing it. Amos has many other tools for achieving the “picture perfect” path
diagram, but we will not take the time to explain them all in this “Getting Started”
tutorial. For more details about drawing functions, refer to the Amos 4.0 Graphics
Reference Guide (either the PDF document or Help file).
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Performing the analysis
The next step is to decide what properties you wish to analyze. Amos gives you an
array of options by following the path: View/Set → Analysis Properties and
clicking on the Output  tab. There is also an Analysis Properties icon you can
click on the toolbar. Either way, the Output  tab gives you these options:

 

For this example, check the Minimization history , Standardized estimates, and
Squared multiple correlations boxes. We are doing this because these are so
commonly used in analysis. In the Examples section, we explore the meaning and
impact of a variety of analytical property options.
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Click the x in the corner of the Analysis Properties dialog box, so you can better
see your drawing area. The only thing left to do then is to have Amos perform the
actual calculations. To do this, click on the Calculate estimates icon on the
toolbar. Amos will want to save this problem to a file, so if you have given it no
filename, the Save As dialog box will appear. Give the problem a filename; let us
say, tutorial1 :

 

Once you click on Save, Amos will begin calculating the model estimates. You can
view Amos’ calculating progress in the dialog box that is always open in the lower
left area of the window. The calculations happen so quickly, you will likely only
see the end of the calculation progress:
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Viewing the text output
When Amos has completed the calculations, you have three options for viewing
the output: text output, table (spreadsheet) output, or graphics output. For text
output, click the View Text icon on the toolbar. Here is a portion of the text output
for this problem:

Minimum was achieved

Chi-square =     0.000
Degrees of freedom =    0
Probability level cannot be computed

Maximum Likelihood Estimates
----------------------------

Regression Weights:                 Estimate     S.E.      C.R.
-------------------                 --------   -------   -------

      SAT <---------- Education     136.022    30.555     4.452
      SAT <------------- Income       2.156     3.125     0.690

Standardized Regression Weights:    Estimate
--------------------------------    --------

      SAT <---------- Education       0.717
      SAT <------------- Income       0.111

Covariances:                        Estimate     S.E.      C.R.
------------                        --------   -------   -------

      Education <------> Income       0.127     0.065     1.952

Correlations:                       Estimate
-------------                       --------

      Education <------> Income       0.485

Variances:                          Estimate     S.E.      C.R.
----------                          --------   -------   -------

                      Education       0.027     0.008     3.162
                         Income       2.562     0.810     3.162
                          Other     382.736   121.032     3.162

Squared Multiple Correlations:           Estimate
------------------------------           --------

                                 SAT       0.603
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Viewing the table (spreadsheet) output
For table output, click on the View Table Output icon on the toolbar. The open
dialog box on the left side of the spreadsheet gives you a variety of output options:
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Click on Parameter Estimates to view the following portion of the table output
for this problem:

 

Notice that output goes to the second decimal place. If you wish to change the
decimal setting, click on either the Increase decimal or Decrease decimal icon on
the Table Output toolbar. Amos 4.0 will display up to four decimal places.
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Viewing the graphics output
To view the graphics output, click the View output icon next to the drawing area.
Your model will display all the properties you specified. However, you must chose
to view either unstandardized or (if you selected this option) standardized estimates
by click one or the other in the Parameter Formats panel next to your drawing
area:

 

If you selected Standardized estimates and assuming that you selected both
standardized estimates and squared multiple correlation in the Output  tab of the
Analysis Properties menu, your path diagram should look like Figure 6:
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Figure 6
The value .49 is the correlation between Education and Income. The entries .72
and .11 are standaridized regression weights. The number .60 is the squared
multiple correlation of SAT with Education and Income.
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Now to see the unstandardized estimates, simply click on Unstandardized
estimates in the open dialog box next to your drawing area. Your path diagram
should now look like Figure 7:
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Figure 7
In the graphics output, you can click between standardized and unstandardized
estimates, if you have specified the analysis of both. But note that you have to
re-run the model (Calculate estimates) after every change to the model, data, or
properties to be analyzed. This is to keep the parameter estimates up to date.

Printing the path diagram
To print the path diagram click on the Print  icon in the toolbox. The Print  dialog
box will appear:

 

For the purposes of this tutorial, you can accept all the printing defaults and simply
click on Print .
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Copying the path diagram
Amos Graphics lets you easily export your path diagram to many word processing
programs, such as Microsoft Word or WordPerfect®. Simply follow the path:

Edit → Copy (to Clipboard)

Then, in your word processing program, use the Paste function to import in the
diagram as a picture or text box. Amos Graphics will only export the diagram
itself, and not the (typically gray) background. You will likely need to resize and
crop the diagram, as Amos Graphics will copy the entire drawing area to the
clipboard, typically leaving lots of extra space around your diagram.

You can also copy table or text output by clicking once and then dragging your
mouse over the desired area (so the text is highlighted). After highlighting the data,
hold down the Control key and the “c” key simultaneously (<Ctrl> - c). This will
copy the highlighted text to the clipboard. Then, switch your word processing or
spreadsheet program and use its Paste function (or press Control and the “v” key
simultaneously; <Ctrl> - v) to import the text.


